Roll Call Lite
Quickstart Guide
Version 11
Table of Contents

INSTALLING ROLL CALL
  Single User Installation ................................................................. 8
  Network Installation ....................................................................... 8
  Installing the Server ...................................................................... 8
  Installing the Client ...................................................................... 8

GETTING STARTED
  Navigator ....................................................................................... 9
  Navigator Menu .............................................................................. 9
  Top Menu ....................................................................................... 9
  To Do List ....................................................................................... 9
  Birthdays ......................................................................................... 9
  Visitors ......................................................................................... 10
  Icons .............................................................................................. 11
  Search/Summary Screens ............................................................... 12
    Customize .................................................................................... 12
    Find By ...................................................................................... 13
    Add or Delete Records ............................................................... 13
    Print ............................................................................................ 13
    Organization Info ........................................................................ 14
    License Number ......................................................................... 14

MAINTAINING PEOPLE INFORMATION
  Import People Information ............................................................. 15
  Enter a new Family ....................................................................... 16
    Contact Information .................................................................... 17
    Address ...................................................................................... 18
    Pictures ..................................................................................... 19
    Phones ....................................................................................... 19
    Add the Next Family Member ..................................................... 20

FINDING PEOPLE
  Search Profile Window ................................................................. 21
    Icon Bar ....................................................................................... 21
    Find By ...................................................................................... 21
    Results ....................................................................................... 22
    Add/Delete .................................................................................. 22
  Customize Search Window ........................................................... 22
  Find Specific Records ................................................................. 23
    Find By Criteria .......................................................................... 23
    Search Window .......................................................................... 23
    Query Editor ............................................................................. 24
  Tag People .................................................................................... 25

ENTERING CONTRIBUTIONS
  Giving Funds ................................................................................ 27
  Batches .......................................................................................... 28
  Check/Cash Contributions ............................................................ 29
    Basic .......................................................................................... 29
    Split ........................................................................................... 31
  Post a Batch .................................................................................. 32
INSTALLING ROLL CALL

Single User Installation

The single user version of Roll Call allows one user, on one computer to access Roll Call. For the single user installation, use the following instructions.

To install Roll Call from the downloaded file, double click on the Roll Call installer file you downloaded. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, you will have a Roll Call icon on your desktop. To use Roll Call, double click on that icon.

Network Installation

A network installation of Roll Call allows multiple people to access the data. If you have a multi-user license, multiple users can access the data simultaneously. For example, if you have purchased a 3 user license, 3 users may access the database at the same time. If you have purchased a single user license, you may still install the network version, but only one person may access the data at a time.

First you must decide which computer will house the database. That computer will be your server. The computer you choose as your server should not be used for many other applications. For example, if your secretary’s computer is used for creating the bulletin, writing letters and accounting, you probably wouldn’t want her computer to be your Roll Call Server. Since the server needs to be running at all times, it would slow down her other work.

Next decide who will need to use Roll Call. Each of those users will need Roll Call Client installed on their computer.

Installing the Server

To install Roll Call Server from the downloaded file, double click on the Roll Call Server installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Server icon on the desktop. To start Roll Call Server, double click on the icon. The Roll Call Server window will be displayed. For users to work in Roll Call the Server must be running.

Installing the Client

To install Roll Call Client from the downloaded file, double click on the Roll Call Client installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Client icon on the desktop. To start Roll Call, double click on the icon. If this is the first time this client has connected to the Roll Call Server, you may get a -1002 error. If this happens, just click through the message. Then you will get a window that has 3 tabs: Recent, Available and Custom. Click on the Available tab. You should see Roll Call listed there. Highlight it and click OPEN.
GETTING STARTED

Navigator
When you start Roll Call, the Roll Call home screen will be displayed in the Navigator Window. The main sections of the navigator are discussed below:

Navigator Menu
The main menu items for Roll Call are found on the left side. If there is an arrow, pointing to the right, there are sub menus underneath that item. Click on the arrow to expand that menu. If an arrow is pointed down, click on it to collapse the menu items. If there is no arrow in front of the menu item, click on it, to perform that function.

Top Menu
Additional menu items can be found across the top of the Navigator Window. These menu items are typically administrative type items, for example, backups, maintenance, and imports. Click on the name of the menu, then move the mouse and select.

To Do List
Each Roll Call user will have a To-Do list displayed on the Home page. To add an item to your To-Do list, click on the plus sign (+) in the lower corner of the area. A window will be displayed for you to enter the task. To mark an item as completed, click on the box in front of the item. To delete items from the list, highlight one or more items, then click on the minus (-) sign in the lower part of the area. To print your To-Do list, click on the printer icon.

Birthdays
The birthday section of the Home page will show you who has a birthday this week, next week, this month, or next month. Use the drop down to choose which time frame you are interested in.

Each Roll Call user, can set their own preferences for this birthday list. For example, the children’s ministry leader may only want to see kids who are in the Sunday school classes
in her list. While a deacon, who is the shepherd for several families, would only want to see the birthdays for the people he is responsible for. To set this preference, click on the Pref icon underneath the birthday area.

To print the birthdays, click the print icon underneath the birthday section. The information displayed in this report is based on what is selected for the birthday report. See the chapter on Reporting on People.

**Visitors**

The visitor section outlines anyone with an association of “Visitor”, who attended or gave last week. To set the preferences for which attendance or contributions to consider, click on the Preferences icon in the lower right corner.

**Church Logo**

If you would like to display your church logo on the Home page instead of the Roll Call logo, select File>Import Logo from the top menu. A “look in” window will be displayed. Navigate to your image file and open it. For the best network performance, this should be a small file.
Icons

There is a standard set of icons you will see on each main Roll Call screen. They allow you to perform many common functions such as printing, querying, saving a set, etc. These icons are listed below

The **printer** icon allows you to print the list that is displayed on your screen. For example, if you were in the people search screen you would get a list of all the people that are in your current list.

The **email** icon allows you to send an email or text all the people in the current list.

The **write a letter** icon allows you write a mail merge letter to the people in the current list. If you are in an individual’s record, you can write a letter to them.

The **label** icon allows you to print mailing labels (Avery 8160) for the people in your list.

The **spreadsheet** icon allows you to put the information displayed on your screen in a spreadsheet program.

The **show all** icon displays all records when pressed.

The **sort records** icon allows you to sort the information in your list by any of the fields in your list.

The **search records** icon allows you to perform a query of the database.

The **special search** icon allows you to perform a predefined query, like finding the heads of the families listed.

The **compare sets** icon allows you to perform a comparison of two results sets. For example, who are my donors that are also in a small group.

The **save set** icon allows you to save the results of a query.

The **get set** icon allows you retrieve the results of a previously saved set.

The **subset** icon allows you reduce your list to only those records that are highlighted.
The preference icon allows you to set user specific criteria based on the window you are currently in. From the search windows, the preference icon will allow you to choose which columns to display.

**Search/Summary Screens**

Each of the main functional areas of Roll Call will have a Search menu item. These Search or Summary screens can be used to find records, correspond with people and add new records.

**Customize**

Each Roll Call user can choose which fields they’d like displayed on a Search screen. To select the columns, do the following:

1. Click on the Search menu item for the area you are interested in.
2. Click on the Preferences icon.
3. Move the columns you’d like displayed from the left side to the right side. You can either drag and drop, double click or highlight the field and click the arrow to the right.
4. To modify the ordering of these columns, drag the field name to the position in the list.
Find By
When you first select a Search menu item, all records will be displayed in the window. To find specific records, you can use the Find By option. Use the Find By drop down to select the criteria you are interested in. Next enter the value for the criteria you are searching for.

Add or Delete Records
Notice the plus and minus buttons (+/-) in the lower left of the Search window. Use these buttons to add new records. Or highlight one or more records and click the minus sign to delete those records.

Print
To print the information that is displayed in your Search window, simply click on the PRINT icon. A report will be printed that contains that same information.
**Organization Info**

When you first begin using Roll Call, you will want to set up your Church or Ministry information. To do this, click Organization from the Navigator menu on the left. Enter the following information:

1. **Organization Name** – Enter the name of the church or organization
2. **Main Address** – Enter the street address for the church or organization
3. **City** – Enter the city where the church or organization is located
4. **State** – Enter the state where the church or organization is located
5. **Zip Code** – Enter the postal code for the church or organization
6. **Country** – If not in the US, enter your country here
7. **Tax ID** – Enter your tax id. This is used on Canadian donation receipts.
8. **Main Phone** – Enter the main telephone number for the church
9. **Main Fax** – Enter the fax number for the church
10. **Website** – Enter the web address for the organization
11. **Current Fiscal Year** – Enter the starting date of the current fiscal year

Enter your church information. This will be the return address on year end receipts.

Make sure to click **SAVE** before you navigate to other menu items.

**License Number**

When you purchase Roll Call, you will be given a **License Number**. You will need to enter that number into Roll Call. To do that select File>Enter License from the top menu. Enter your number and press the tab key. The number of users and number of allowed records will be filled in for you. Click OK to save the number.
MAINTAINING PEOPLE INFORMATION

Import People Information

When you begin using Roll Call, you may wish to import your existing contacts into the database. Roll Call allows you to import people contact information and some custom fields from a tab delimited text file. If you have the information in Excel, you can create the tab delimited file, by saving as “tab delimited text file”.

Once you have created the file that will be imported, do the following to bring the data into Roll Call.
1. Expand the People menu on the left side.
2. Click on Import People (You can also select File>Import People from the top menu).
3. From the window that is displayed, select your file format type, click NEXT.
4. From this window, select your default Association and default Family Position. These fields are required, so if you don’t have a value in the record, Roll Call will use the default value to create the record in Roll Call.
5. Indicate which row the data starts. For example if you have titles in row 1, the data would start on line 2.
6. Click LOAD FILE. Navigate to your text file and open it. Your data will be displayed in a spreadsheet fashion in the lower section of the window.
7. If you selected a custom file format, you will need to use the drop down box at the top of each column to define the data represented in that column. If you do not want to import the data in a column, leave the selection as SKIP.

Click on Import menu item.

Choose file format type, then click NEXT.

Enter defaults for Association and Family Position.

Click LOAD FILE, navigate to your date, then click OPEN.
Enter a new Family

To enter people information into Roll Call using the Add Person screen you can do either of the following:

1. From the Search Profiles (under People), click on the plus (+) sign in the lower left.
2. OR, Open up the People menu (left sidebar) and click Add a Family.

You are now in the Add Person screen. If you are entering a new family, enter the person who will be marked as Head of Family first. When you first come into the form, you’ll be in the Family Position field. Based on your selection here, the Title, Gender and Marital Status can be filled in.
Contact Information

Once you’ve entered the Family Position, you can tab through each of the fields on this main page. Enter the following information:

1. *First Name* - enter the person’s full first name.
2. *Nickname* - the nickname will default to the value entered for the first name. You can change this to the nickname if it is different than the first name.
3. *Middle Name* – enter the middle name. This field is not required.
4. *Last Name* – enter the last name. This field is required. If you are entering a business, enter the business name in the last name field.
5. *Suffix* - enter the suffix Jr., Sr., etc if applicable.
6. *Spouse* - if the person you are entering is married, you can enter the spouse’s name here.
7. *Association* – enter how this person is involved in the church. Are they a Member, Regular Attender, Visitor, etc.
8. *Birth Date* - enter the full birth date for the person.
9. *Primary & Alt Phones* - enter the phone numbers for the family here.
10. *Unlisted* - if the family doesn’t want their phone numbers listed in directory check here.
11. *Head of Family* – this box will be checked for the head of family. Each family needs one and only one head.
12. *Personal Email* – an email address for this person.
13. *Envelope Number* – you may enter an envelope numbers here, or use the assign envelope number option under the Bulk Changes menu to assign numbers en masse.
14. *Family Number* – if you selected “automatic” from preferences, this number will be assigned by Roll Call. Otherwise, you may assign a family number manually.
15. *Badge No.* - if the family position is child, a badge number will be assigned. You may enter a different number if you’d like.
16. *Barcode No.* – the barcode number is used to identify individuals and families for child check-in. This number is automatically assigned by Roll Call, unless you have the preference set to manually assign the number.
Address

Next, we’ll move down to the address/pictures tab on the People screen. Notice there are three tabs underneath Address. You can now click on the tab to enter Primary Address, Alternate Address and Notes. The Primary address is the families main address. The Alternate address if for folks who live in a different part of the country for part of the year. The notes section can be used to enter driving directions.

Enter the following information on the Primary address tab:

1. **Optional Mailing Name** - The name entered here will be used as the mailing name on all correspondence and labels. For example, if you have a husband and wife Jim & Sue Smith, the default mailing label would be Jim & Sue Smith OR Mr. & Mrs. Smith. However, if you entered “The Smith Family” as the optional mailing name, the letters, labels and receipts would be addressed to “The Smith Family”.
2. **Address, City, State and Zip**.
3. **Country** – if you have the preference turned on for country there will be a country field displayed here.
4. **Shepherd Area** – if your church assigns deacons, congregational care pastors or other lay people to come along side families, you may indicate that here.
5. **Family Email** – an email address that can be used to send emails to the entire family.
6. **Bad Address** – if you’ve had mail returned, so you know it is an invalid mailing address, you can mark the box for “bad address”.
7. **Do not send mail** – if someone has requested that you not send them mail, mark this box.
8. **Unlisted Address** – if someone has requested that their address is not published, mark this box.

If you need to enter a secondary or alternate address, click on the ALT Address tab. Enter the following information:

1. **Address** – the street address for the alternate address.
2. **More Address** – the address line 2.
3. **City, State and Zip** of the alternate address.
4. **Country** – if you have the preferences to display country, you can enter the country here.
5. **Phones** – enter the home phone numbers for the alternate location.
6. **Effective Month & Days** – enter the start date when this address takes effective.
7. **Ends Month & Day** – enter the moth and day that this address should no longer be used.
To enter Notes regarding the address information, click on the Notes tab. Enter the free format information here.

If you’d like directions to an address, click on the WEB MAP button on the bottom of the page. If you’d like to copy the address onto the clip board to paste in another application, click COPY ADDRESS.

**Pictures**

You can pull in family pictures and/or individual pictures into Roll Call. Click on the Address/Pictures tab. Notice the two tabs on the right side for Picture and Family Picture.

The individual picture should be a portrait picture. To pull in the individual picture do the following:
1. Make sure you are anchored on the Picture tab (click on the word Picture).
2. Click on the plus sign (+) in the lower left.
3. Navigate to your image file and click OPEN.

The family picture should be in landscape. To pull in the family picture do the following
1. Make sure you are anchored on the Family Picture tab (click on the word Family Picture).
2. Click on the plus sign (+) in the lower left.
3. Navigate to your image file and click OPEN.

**Phones**

To enter an individual’s phone numbers, click on the Phones tab. Enter the following information:
1. *Work Phone & Extension* – enter the person’s work number.
2. *Cell Phone* – enter the cell phone number for this person.
3. *Pager* – enter a pager number for this person if they have one.
4. *Fax* – enter a fax number for this individual.
Click on the Phones tab.

Enter an individual’s phone numbers.

Click to add additional phone numbers.

Add the Next Family Member

Once you have added all the information for an individual, you can do several things:
1. Click SAVE & CLOSE. This will save the information you entered, and return you to the Search People window.
2. Click SAVE & NEW, then select ADD NEW FAMILY MEMBER. This action will save the information you just entered. You will be taken to the People Information window, with the family information displayed. At this point you can start entering the information for the wife, children or other family member.
3. CLICK SAVE & NEW, then select ADD NEW FAMILY. This option saves the information you just entered. Then you will be taken to the People Information window to begin entering a completely new family.

Click SAVE & NEW to add a new family member. A drop down will appear for you to select new family or new family member.
FINDING PEOPLE

Search Profile Window
To find records in Roll Call, use the Search window. To find specific people, expand the People menu, then click Search Profiles. There are several main sections of the Search window:
1. The icon bar.
2. The Find By drop down and criteria.
3. The results.
4. The add and delete buttons.

Icon Bar
Note the icons across the top of the Search window. These icons allow you send emails, write letters or create labels for the people that are in the list. You can also print the list, do more detailed queries or do special searches. For more information on these icons, see the Getting Started – Icons chapter.

Find By
Note the drop down box to the right of “Find by”. Use this drop down to choose the criteria you’d like to use to find specific records. The field to the right allows you to enter the value you are looking for.
Results
As you type in the value you are looking for, the result set will change. For example, if you choose to find by “last name”, and start entering Crumb, when you type in C, you’ll get a list of all names that start with C. As you type “m”, the list will be reduced to those last names that start with “Cr”.

From the results list, simply double click on a record to view the detail information for that person.

Add/Delete
In the lower left of the results section, notice the plus and minus (+/-) signs. Click on the plus sign to add a new record. Click on the minus sign to delete records from this list.

Customize Search Window
The Search window for People shows the following information: Last Name, First Name, Head of Family checkbox, Association, Family Position, Individual Email, Home Phone, Address 1, City, State and Postal Code.

If this information is not all displayed on your screen, you can use the scroll bar at the bottom of the window to view information that is off the screen. If you have a larger monitor, you can drag the lower right corner of the window to enlarge it.

Each Roll Call user can set preferences for what fields they’d like displayed in the Search window. To change the display fields:
1. Click on Pref’s icon.
2. Drag a field from the left side to the right side.
3. To re-order the fields, drag the field up or down on the right side.
4. Click SAVE & CLOSE to save changes.
Find Specific Records

**Find By Criteria**
To find people by Last Name, First Name, Association, Family Position, Email, Street, City, Postal Code, Family No, Badge No, Envelope or Keyword you can select that criteria from the Find By drop down box. Once you’ve selected your criteria, enter the value you are looking for in the field to the right. The results will be displayed below.

**Search Window**
If you are searching for people by their Last Name or by a Keyword, use the Search box on the right side of the screen. Enter the name or keyword, then press Enter. Your results will be displayed.
Query Editor

If you need to search for people by a field that is not listed in the Find By drop down box, you will need to use the query editor. To use the query editor, do the following:
1. Click on the SEARCH icon.
2. Select a field from the Field drop down box on the left side of the window.
3. Select your comparison operator.
4. Enter the value you are looking for.
5. Click QUERY.

In this first example, let’s say we have a custom date field that we set up for *Baptism Date*. We want to find all folks who were baptized this year.

1. Click on SEARCH icon.
2. Choose Baptism Date.
3. Choose “is greater than” as the comparison.
4. Enter “01/01/11” as the date value.
5. Click QUERY.

The results of our query. So we know that these people have a baptism date later than 1/1/11.
In this next example, let’s say we want to find folks that are Members, Regular Attenders or Occasional Attenders.

1. Click on SEARCH icon.
2. Click on the Association tab.
3. Click over the Associations Member, Regular Attender and Occasional Attender.
4. Click QUERY.

For more details on using the query editor, see the “Using the Query Editor” chapter.

Tag People

If you are a deacon responsible for a certain group of people, or a children’s minister responsible for the children, you may want to “tag” those people that you work with most often. By tagging people, you can go straight to the Tagged People menu item, under Home to see those folks.
To tag people, do the following:
1. Do a query or find by to get the people in the list.
2. Highlight all the people you’d like “tagged”.
3. Right mouse click.
4. Select “Tag”.

To view the “tagged” people, do the following:
1. Expand the Home menu.
2. Click on Tagged People.
3. Your tagged people are listed here.

To “un tag” a person, do the following:
1. Expand the Home menu.
2. Click on Tagged People.
3. Highlight the folks you no longer want in your list.
4. Right mouse click, and select “unTag”.

Expand the Home menu, and click on Tagged People. Your “tagged” people are listed here.

Highlight the people you wish to remove from your list, right mouse click and select “unTag”.

22
ENTERING CONTRIBUTIONS

Giving Funds

Before you can begin entering contributions in Roll Call, the giving funds must be defined. The giving funds are the designations that people can contribute to. A new Roll Call database will contain one giving fund, “General”. To add giving funds, do the following:

1. Expand the Contributions menu on the left side bar.
2. Click on Giving Funds
3. Click on the plus sign in the lower left of the Giving Fund summary window.

4. Enter the Fund name. This is the name that will be in the drop down box to select designations from the Enter Contributions screen.
5. Enter the associated Account Number. This number is not mandatory.
6. If this giving fund is no longer valid or used, check the “Inactive” box.
7. If this fund is not tax deductible, mark the box for “Not on Receipt”. If this box is checked any monies given to this fund will not be printed on the year-end tax statement.

Click on Giving Funds, under the Contributions menu.

Click on the plus sign to add a new fund.

Enter the fund name and account number.

Enter GL Account mapping information.

Click SAVE to save the information.
8. Select the Fund Color. This color will represent the fund in pie charts showing total giving. Click on the “…” and click on the color you’d like to use.

9. The **GL Fund** is used to map the giving funds to your accounting system. For example if you have a giving fund of “Tithes & Offerings” and you want that to map to the General Income Fund in your accounting system, you would enter General Income as the GL Fund. If you are importing into Quickbooks and your fund is a sub-account, enter the Account, then a colon then the sub account name, for example, Operating Income:General.

10. The **GL Account Number** is the account number to map to MYOB accounting.

11. GL Key is the number to map to Roll Call’s accounting system.

**Batches**

All contributions are entered in Roll Call through a batch. A batch is nothing more than a grouping of contributions. Typically, users will enter all the giving for a deposit in a batch.

Because of the integration with Accounting, batches must be either Cash or Non-Cash. Cash contributions include all cash, checks, credit cards and ACH type transactions. Non-Cash batches contain property gifts, things that cannot be deposited into the bank.

To create a batch, do the following:

1. Expand the Contributions menu on the left side bar.
2. Click on Add Batch.

Enter the following information:

1. **Batch Date** – This date will become the default for all contributions entered in this batch.
2. **Description** – Enter a qualifying description of this batch. Especially if you will have multiple batches for the same day. Maybe this group of contributions is for the 9 a.m. service. You could enter “9 a.m. service” as the description.
3. **Anonymous Cash** – Enter the amount of loose cash that was in the offering. This is cash that cannot be associated with any specific donor.
4. **Cash Fund** – Enter the fund that the anonymous cash should be designated to.

5. **Default Fund** – Enter the fund that you’d like all contributions in this batch to default to. This doesn’t mean that you can’t have other funds included in this batch. This is only used as a default. If the majority of the giving is for Tithes & Offerings… make “Tithes & Offerings” the default fund.

6. **Batch Type** – Select Cash for batches that will contain cash, checks, credit card, online, ACH type contributions. Select Non-Cash for property or in-kind gifts.

7. **Asset Fund** – This is the fund to map non-cash gifts to the appropriate asset fund in your accounting system.

8. **Batch Control Count** – This field can be used as a control count for the number of entries expected in this batch. This field is not required, but by using it you may be able to catch any data entry errors. If the Batch Count and Batch Control Count do not match, they will be displayed in red.

9. **Batch Control Total** – This field can be used as a control total for the amount expected in this batch. This field is not required, but by using it you may be able to catch any data entry errors. If the Batch Total and Batch Control Total do not match, they will be displayed in red.

10. To begin entering individual contributions, click on the plus sign in the lower left corner.

### Check/Cash Contributions

To begin entering cash or cash equivalent contributions, you will need to create a batch. To create a new batch, do the following:

1. Expand the Contributions menu.
2. Click on Add Batch.
3. Enter the batch header information as described in the previous section.
4. Click on the plus sign in lower left to begin entering the contributions.

To enter new contributions to an existing batch, you will need to locate your batch.

1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Change the Find By Criteria to “Date”.
4. Select the date of the batch you are adding to.
5. Double click on the appropriate record.
6. Click on the plus sign in the lower left to begin entering new contributions.

### Basic

To record a donation, enter the following information:

1. **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of the contribution.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.
6. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.

Enter the last name of the donor. Press the TAB key.

Select from this list, or reduce the list further by typing the first name.

Enter the amount, check number and donation type.

Select the fund to designate this contribution to.
Split

A split donation is a single contribution that needs to be designated to 2 or more funds. To record a split donation, enter the following information:

1. **Donor Name or Envelope Number.** When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of the contribution.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.

6. **Amount** – Notice the amount and designation fields underneath the contribution header information. Place your cursor in the amount field, and reduce the amount so that it matches the amount to be designated to the first fund. Press TAB. Note a 2nd line is created with the remainder, so you can designate that amount.

7. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to the Batch window.
Post a Batch

Posting a batch in Roll Call sets several things in motion. When you post a batch:
1. The batch can NO LONGER be modified.
2. If you are using Roll Call Accounting the receipt information will be sent to the accounting system.
3. If you are using Quickbooks or MYOB, you can create your export files as part of the posting process.
4. As part of the post process you can choose to print the batch summary and batch detail report.
5. As part of the post process you can choose to print a deposit slip.

To post a batch do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight one or more batches that need to be posted.
4. Click on POST BATCH button in the lower right of the window.
5. You will be presented with a list of reports to run. Check the options you’d like to print.

From the batch window, click on POST to post the batch.

From the Search by Batch window, highlight one or more batches and click POST.
Mark the reports you’d like to run and the export files you’d like to create.

Click POST to run the reports and post the batch.

**Import deposit to QB or MYOB**

When you post a batch in Roll Call you will be given the option to export for MYOB or Quickbooks. If you marked either box to create an export file, you will be prompted for a folder to create the file in. The file will automatically be named. Next you will be prompted for the bank account name that you’ll be depositing the money into.

To import the file in Quickbooks, do the following:
1. Open Quickbooks.
2. Select File>Utilities>Import>IIF files.
3. Navigate to the file you just created.
4. You should now have a deposit journal entry representing the batch.

To import the file into MYOB, select File>Import. Navigate to the file you just created. You now have a deposit journal entry that represents this batch.

**Batch Reports**

There are two batch reports available when you post a batch. The first is the batch summary report. This report will outline how much was given to each fund in this specific batch. The second report is the batch detail report. It will outline each donor and how much was given.

To run these reports, mark the box for Batch Summary and or Batch Detail after you choose to Post the batch.

The Batch Summary shows how much was given to each fund in this batch.
The Batch Detail lists all donations included in a batch.

Deposit Slip

When you close a batch there is an option to print a deposit slip for the batch. Check the box to print the deposit slip. Click OK.

Mark the box to print a deposit slip for the current batch.

If you'd like a deposit slip to include multiple batches, highlight those batches, choose to close, then mark combined.

Lists contributions.

Totals by cash and check.
RUNNING REPORTS

The majority of reports in Roll Call are run in the same manner. This chapter discusses the methodology for running reports and walks you through much of the terminology. Whether you want a list of people, an attendance report, a contribution report, a pledge report or a group report, you will process them in the same manner.

Report Selection Window

To begin, you’ll need to decide which report you’d like to run. There is a report option under each of the main menu options on the left sidebar. For example, if you want to run a contribution report, expand the Contributions menu and select Reports. The report selection window for contribution reports will be displayed. Choose the specific report on the left sidebar of the window.

Expand the menu for the area you wish to report on, then click Reports.

Select your report on the left hand side.

Enter date range and other criteria.

Click GENERATE to run the report.

Notice there is also a Reports menu on the top menu. Once you drop down the reports menu you can choose People and Contributions. Again, the Report Selection window will be displayed for the area you choose.

Depending on the type of report you selected, there will probably be 3 tabs in the Report Selection Window: Criteria, Columns and View People. There may also be tabs across the middle of the page: Who, and What.
**Criteria**

Most reports will be anchored in the Criteria tab. The information on the criteria tab will change based on what report you are running. For example if you were running a contribution report, the criteria tab would allow you to enter the date range of contributions you wanted to include in the report.

![Criteria tab example](image)

**Who**

If the report you are running is for certain people, attenders or donors there may be a “Who” tab on the Criteria section. The Who tab allows you to select who should be considered for the report. For example, you will be able to run the report for certain associations, keywords, shepherd areas or by using the query editor. First select the type, association, group, etc. Then choose the specific values you are interested in.

![Who tab example](image)

For example, if you wanted a list of your members who donated to a certain fund, you would select association as the type, then click over Member to the selected column.
What
The “What” tab is used to further refine your criteria. For example if you are running a contribution report, which funds should be included. If you are running an attendance report, which attendance should be included.

Columns
Once you’ve identified who will be considered for the report, click on the Columns tab to change what data is included in the report. Each report has a standard set of columns that will be displayed, but if you’d like to change that, use the columns tab.

All the columns that are available for the report will be listed in the left column. If there is an arrow in front of a word like People or Addresses, this means you can expand the list of fields under that table. There is also a section called Special Columns. Special Columns combine pieces of information into one field. For example if you want the Head & Spouse as a field, or Parents Names as a field, these can be found under Special Columns. For a full listing of tables, field names and descriptions please see Appendix A.

View Records
The View Records tab allows you to see which people or data will be included in the report based on the criteria you selected.

Run the Report
When you click GENERATE, the report results will be displayed in the Report Output window.

Report Output Window
The report results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
Click on Columns tab to pick fields for the report.

Double click or drag a field from left column to "selected" column.

Move the selected columns around to order them in the report.

3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.

These people will be included in the report.

Click GENERATE to run the report.

9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER (not available in RC Lite), to compose a mail merge letter to this list of people.
11. Click EMAIL (not available in RC Lite) to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in your report. If you choose Email report, the email editor will be displayed. You will need to enter the email address of the person you are emailing. Enter any introductory text in the body, the report will be sent as an attachment. Click SEND.
12. Click GRAPH to view the report data in a graphical format. This option is generally available for summary by week, month or year type reports.
13. To enlarge the window, click on the lower right corner of the window and drag to the appropriate size.
Report results.

Note actions that can be performed.